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Description 

AutoCAD Electrical provides many tools to configure the software specifically to the design 
environment and workflows of your company. Do you have specific folders and paths for your 
custom files? (Hint: You Should!) We will show you where to set these for everyone on your 
design team. We cover the WD.ENV, WD_M.dwg, WD_PNLM.dwg, DEFAULT.WDT, and many 
other reference files. Tired off making the same old picks and clicks to start your drawings, or 
save custom files? Join us to enter brave new world of enhanced productivity. 
 
 
 
 
 
 
 
 
 

Speaker 

Randy Brunette is a Technical Consultant with Spatial Business Systems, Inc. specializing in 
AutoCAD Electrical and related products including Inventor, Vault, and the Substation Design 
Solution (SDS) Toolkit. As a Technical Consultant, Randy’s duties include helping customers 
through mentoring and understanding their business issues and finding solutions that solve their 
challenges. Randy has been in the design field using Autodesk products for over 35 years, with 
experience across many different segments of the manufacturing industry. He has been in an 
application engineer role for 23 years, traveling throughout the world providing consulting 
services. Randy is a top-rated speaker at Autodesk Universities, Technical Academies, and 
seminars. He has authored AutoCAD Electrical software training manuals, videos, and other 
materials. 

  Learning Objectives 

• Configure and save the WD_M.dwg as a template for standard drawings. 

• Configure the WD.ENV file to match company environment standards 

• Create both project specific and company specific references files 

• Troubleshoot missing or incorrect paths and library searches. 
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Modifying the WD.ENV Environment File 

About the WD.ENV File 

AutoCAD® Electrical uses a startup or environment file (WD.ENV) to establish default search 
paths for the software.  These include retrieving from and saving to symbol libraries, part 
catalog databases, project settings, menus and more. Some of these settings are overridden by 
project settings, others are controlled only by the WD.ENV file. 

With a standard stand-alone installation, the WD.ENV file is located in the AeData folder, 
located in the Documents folder location.  The default location is 
“C:\Users\{username}\Documents\Acade {ver}\AeData\”.   

You can create an alternate environment settings ENV file and assign it to the active project. 
Customer-specific ENV files can be created to store customer settings, paths, libraries, and 
menus. Whenever the project is selected, the settings in the referenced ENV file are restored 
automatically. 

Editing the WD.ENV File 

You must use an external file editor such as Wordpad, Notepad, or Word to view and edit the 
WD.ENV file. 

 

The format for each line in the file is: environment code,setting,description (separated by 
commas). 

Any text following an asterisk (*) in each line is a comment and it will be ignored by AutoCAD 
Electrical. This enables you to add notes or comments to each line to clarify the line setting, or if 
the asterisk is at the start of the line, comment out the line entirely. 

The WD.ENV uses comments frequently to help you determine what each code is and how it 
can be formatted. 

Path Aliases 

You can take advantage of path aliases within the WD.ENV file. Use the alias to reduce clutter 
in the file and maximize flexibility with the file. The aliases adjust to the installation and paths on 
each individual computer. While there are several, two of my favorite ones are %SL_DIR% and 
%WD_DIR%. 
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%SL_DIR%  In a stand-alone installation, this represents the base folder for AutoCAD 
Electrical "Libs" symbol library subfolder. An example is 
C:\Users\Public\Documents\Autodesk\Acade {ver}\Libs\ 

Using the %SL_DIR% alias enables the same WD.ENV file to be used with multiple 
versions of AutoCAD Electrical. For example, if one user has 2019 installed and another 
has 2020 installed, the same WD.ENV file will automatically path to the correct symbol 
library. Here is an example of this being used in the WD.ENV file (word wrapping in effect): 

WD_LIB,%SL_DIR%/NFPA;%SL_DIR%/NFPA/1-
;%SL_DIR%/pneu_iso125;%SL_DIR%/pid 

 
Without using the alias this same line would be listed like this (word wrapping in effect): 

WD_LIB C:\Users\Public\Documents\Autodesk\Acade 2020\Libs\NFPA 
C:\Users\Public\Documents\Autodesk\Acade 2020\Libs\NFPA/1-; 
C:\Users\Public\Documents\Autodesk\Acade 2020\Libs\pneu_iso125 
C:\Users\Public\Documents\Autodesk\Acade 2020\Libs\pid 

This alias can also be very useful when sharing project files (WDP), and for the same 
reasons. When sharing the project files, the paths will automatically adjust to the receiving 
persons computer using their installed library paths. 

%WD_DIR% This represents the base folder where the WD.ENV file is located. This alias is 
very useful when the WD.ENV file is moved to a shared location. An example is 
M:\Engineering\AcadE\ 

This path can then become the basis for the storage of project files, custom folders, 
basically all AutoCAD Electrical specific files. 

Note: You can use different aliases in different lines in the WD.ENV file, but only one alias can be 

used in any one line. 
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Here is an example from a WD.ENV file of the Symbol Insertion and Library Paths where the 
shared files are located at: I:\CAD\AutoCAD Electrical\AeData\ 

 

Notice that the WD_LIB and WD_PNL lines uses both the specific path and the %SL_DIR% 
alias. The remaining lines use just the %WD_DIR% alias.  

Here is what that looks like in Windows Explorer. 
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Managing the WD.ENV File 

If the WD.ENV file is stored in a network drive, use   (setq GBL_wd_DocSetWDBase 
"Z:\\") to  change the directory. Z drive is the network drive in this example and adhere to the 
format to execute it properly in command line of AutoCAD Electrical. For example, the WD.ENV 
file is saved under Z :\Engineering\CAD folder, then the command should be   (setq 
GBL_wd_DocSetWDBase "Z:\\engineering\\cad"). 

Creating an Alternate Project-specific Environment File.  

1. Copy the WD.ENV file and rename it to a {projectname}.env. 

2. Open and edit this new file in an external text editor such as Notepad. 

3. Change the path for the library symbols and other settings as required. 

4. Save to the same folder as the original WD.ENV file. If the modified file is for a specific 

project or company, give it a different name. 

 

Note: All environment files, including the project-specific files, must be stored in the same 
folder as the default WD.ENV file. 

 
5. If the a specific WD.ENV file is desired for a project, in the Project Manager, right-click 

the project name, select Settings, and then click Environment File button to select the 

project-specific ENV file for use. 

Making changes to the environment is relatively easy and can return great dividends, but it is a 
detail-oriented process. If errors do occur is usually because of typographical errors or incorrect 
syntax. Just review your edits to verify the correct information is entered. 

Manage Environment in a Multiple User Installation 

If not using a deployment to establish the multiple user installation you will need to change the 
environment search paths manually. Here is a simple way to accomplish this task. 

1. Copy the entire AeData folder to your shared network location. In the example shown 
above, this is I:\CAD.  

2. Rename the original AeData folder. For example, AeData_Bak. This will prevent 
AutoCAD Electrical from finding it during the default start routines. If away from your 
network, you can then easily rename the folder back to the original name to enable you 
to work “off network”. 

3. Start AutoCAD Electrical. Open the Options dialog box and do the following: 
a. On the Files tab, select Support File Search Path. 
b. Click Add. 
c. Click Browse. 
d. Select the shared network folder. In this example, I:\CAD. 
e. With the new folder selected, click Move Up as needed to move the new folder to 

the top of the list. 
f. Click Apply. 
g. Click OK. 

In the WD.ENV file set your paths to look in this folder as shown in the examples above. 

This can make future changes much easier. For example, if you share folder moves to a 
different location, you simply change the path in the Options to point to the new path. 
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Modifying the WD_M Block, and Creating Templates 

About the WD_M.dwg Block 

In schematic drawings a block named WD_M.dwg is used to 
contain default settings for the tools in AutoCAD® Electrical.  The 
WD_M block does not have any graphics associated with it and 
contains only invisible attributes. The block is inserted at the 0,0 
point in the drawing and is invisible. The only way to see the block 
is to use the ATTDISP or ATTMODE commands to set the visibility 
of the attributes to On. A unique WD_M.dwg file is in each of the 
symbol libraries installed with AutoCAD Electrical and contains the 
settings particular to that symbol library.  

In panel or physical style drawings a block named WD_PNLM.dwg 
is used for the panel drawing settings. This block is edited in 
AutoCAD Electrical using the panel Configuration tool. A drawing 
may have both the WD_M.dwg and WD_PNLM.dwg blocks inserted 
in it. 

If the drawing does not have the WD_M.dwg or WD_PNL.dwg 
inserted, starting an AutoCAD Electrical command will prompt you 
to insert the appropriate block. If you deny permission, the 
command will still run, but every time another command is run, or 
more information or default values are required, you will be 
prompted again to allow the insertion of the block. Eventually you 
will not have to execute any more commands, or you will give up 
and allow the block to be inserted. 

While the WD_M.dwg and WD_PNLM.dwg blocks contain default 
information and settings for the drawing, you don’t have to worry 
about remembering all the attribute names and correct values to 
enter. In schematic style drawings, the Drawing Properties 
command and dialog box does this for you. Basically, the Drawing 
Properties command is a specialized attribute editing tool that edits 
only the WD_M.dwg block. In panel style drawings, the 
Configuration command and dialog box is used to edit the WD_PNLM.dwg block. 

When creating an AutoCAD® Electrical template be sure to have these blocks inserted to avoid 
being prompted to insert it for each drawing.  You should modify the WD_M.dwg and 
WD_PNLM.dwg to match your most common company settings. This will avoid having drawings 
being different if you do start with a template, or use a file, that does not already have the blocks 
inserted.   

Managing the WD_M.dwg and WD_PNLM.dwg Blocks 

Modifying the WD_M.dwg and WD_PNLM.dwg blocks directly can be confusing and difficult. A 
much easier way to manage the files is by using the tools found in the ribbon, on the Project tab, 
Other Tools panel flyout. 

Example of WD_M and 
WD_PNLM blocks with 

ATTDISP set to ON. 
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The first step is to start a new drawing and start the Drawing Properties command. If the 
drawing already contains the WD_M.dwg block, the Drawing Properties dialog box will appear. If 
the drawing does not contain the block you will be prompted to insert it. Use the dialog box to 
change the drawing settings to match your company standards. 

When the setting changes are complete use the Update Symbol Library WD_M Block tool to 
overwrite the existing symbol library block. This will ensure the custom settings will be used 
consistently in future drawings. The tool is located here: 

  

 

If you have existing drawings completed in AutoCAD® Electrical before you modified the 
WD_M.dwg file, you can update the legacy drawings to the new standards by using the ‘Update 
to New WD_M Block, Values, Layers’ tool. The tool is located here: 
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Title Block Setup and Title Block Update 

Project Description Line Aliases 

Generic project description lines are labeled as Line1, Line 2, Line3, and so on. You can create 
aliases for these generic values using an external reference file named default_wdtitle.wdl. 
These aliases are also used in the Title Block Setup tool when mapping project description 
lines. That’s why it is recommended to setup the default_wdtitle.wdl file before starting the title 
block attribute mapping process. 

The file contains one line per label in the format LINEx=label. The entries do not have to be in 
order and line numbers can be skipped. If a blank line is desired in the Project Description 
dialog box, enter a space for the mapping. Here are before and after examples: 

 

 

Without default_wdtitle.wdl          With default_wdtitle.wdl 

Title Block Attribute Mapping 

Once the data is mapped to the title block you can update single or multiple attributes, for the 
current drawing, or across the entire project. 

Use the Title Block Setup tool to map project, drawing, and other data to attributes in any block. 

Note: Your title blocks must contain attributes for title block updating to work. 

The tool is located on the Project tab, Other Tools panel.  
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Title Block Mapping Styles 

In general, AutoCAD Electrical uses three different search paths for locating and using available 
reference files, including the title block mapping files. (In the following examples WDT could be 
any of the reference file types such as WDD, WDR, LOC, etc.) 

<Project>.wdt Project-specific file that is referenced only by a project the with the same 
name. This file must be in the same folder as the WDP file. 

Default.wdt Default for any project found in the same folder and a project-specific.wdt file 
does not exist. 

Default.wdt Default used when neither of the above files are found. 

WD_TB For title block reference files you have an additional mapping option using an 
embedded WD_TB attribute. 

You will need to select the version of data mapping you prefer. External WDT files can be 
project-specific, folder default, or company default, as explained earlier for other reference files. 
Alternatively, you can use an attribute embedded onto the title block itself. Each method of 
storing mapping information has advantages and disadvantages. 

 

Method Advantage Disadvantage 

External 
File 

External files are easy to edit and change, 
especially when working with client title 
blocks, because no changes to the title 
block are necessary. You can edit these 
files at any time with any ASCII editor or 
the Title Block Setup utility. This method is 
used more frequently when you work with 
a variety of title blocks from different 
companies. 

External files must be in the project 
search path. Because the data is not 
contained in the drawing itself, it is 
not necessarily transferred when the 
drawing is moved. 

Internal 
Attribute 

Because the invisible attribute WD_TB is 
embedded in the title block definition, the 
mapping information goes wherever the 
title block goes. This mapping information 
is seldom lost and is more difficult to 
change unintentionally. 

Because internal attributes are 
stored in title block definitions, title 
blocks must be exploded to edit 
these attributes mappings with the 
Title Block Setup utility. You can 
manually edit the mappings, without 
exploding the block, using an 
attribute editing command. This 
method is used more frequently with 
internal title blocks that change less 
frequently. 
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Hint: Create an external Default.wdt file first to complete setup and testing. Once title block 
updates are working correctly, move or rename the file as needed. Or use the mapping 
information in the text file to help setup the internal WD_TB attribute. 

Title Block Attribute Mapping-Project Description Lines & Drawing Values 

After selecting the title block or blocks you want to map to, the Title block Setup - Project dialog 
box appears.  

 

 

The tool extracts the attribute names from the 
blocks you select. These appear in the 
Attribute selection boxes. For each Project 
Description Line value, select the attribute 
where the value will be placed. If you don’t 
know or recognize the attribute name, use the 
Pick option to select the correct attribute in the 
drawing. 

Select the Drawing Values button to repeat 
the process using Drawing Specific values. 

Use the User Defined option to map text 
constants or AutoLISP expressions to title 
block attributes. An excellent example is 
shown in the dialog box for mapping the 
computer LogIn name to an attribute. 
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Mapping to Multiple Blocks 

As a standard setup workflow, the Title Block 
Setup tool allows you to map different attributes 
in multiple blocks. This is useful when you have 
one block for the border and another for the 
revision information, both can be updated using 
only one WDT file. 

Note: You cannot map the same electrical information to multiple attributes. Fields can be a 
useful alternative when this is required. 

Here’s where a little manual editing can be very useful. For example, in the class dataset, 
Configure_ACADE_Productivity-11.dwg has a different title block, with different attribute names, 
than the other files. To enable mapping to both sets of attributes at the same time, you open the 
WDT file using any ASCII editor and make manual edits, adding the additional mappings.  

In the example from the Configure_ACADE_Productivity.wdt file in the class dataset, notice 
there are multiple occasions where the AutoCAD Electrical information is mapped to several 
attributes.  

This line contains mappings to two 
different title blocks. 

This area shows the mapping of the 
SHEETMAX variable to both attributes, 
SHTS, and OFSHEET, each from 
different title blocks. 

This area shows the mapping of the 
project description attributes to multiple 
title block attributes. 

 

Caution: Using the Title Block Setup tool to map attributes after manually editing the WDT file 

overwrites the file with only the lines mapped in the tool. Duplicate lines and other manual 

edits will be lost! 
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Project Reference Files 

AutoCAD Electrical uses generic file formats such as Excel files, Access databases, and ASCII 
text files to contain reference information used by the AutoCAD Electrical functionality.  For 
example, the part number and pin list tables are stored in Access or SQL databases for speed 
and ease of use.  Project file information, title block mappings, and default lookup lists are 
stored in ASCII text files. 

AutoCAD Electrical uses these generic formats to help minimize typographical errors and 
encourage consistency in data entry.  Not only does AutoCAD Electrical provide wizards and 
tools for editing most of the files, but the all data files can be easily edited by users with any 
compatible program or editor.  Users can even write custom programs to access and 
manipulate the data in these files as needed for internal company processes. 

Project Reference Files and Descriptions 

File Name Description Format 

Default.wdu Stores the settings from the Update 
Title Block dialog box. 

No formatting required 

Default.inst Installation codes One text string per line 

Default.loc Location codes One text string per line 

Default.wda Contains list of user defined 
attributes to be included in reports. 

Formatted automatically by 
the User Defined Attributes 
tool. See Help to manually 
define. 

 

Default.wdt Maps AutoCAD Electrical data to 
title block attributes. 

Block = {block name} 

Attribute = {AcadE Data} 

Default_wdtitle.wdl Project Description LineX labels. 
Very useful when used with title 
block update tools. (Note: Only the 
“default” portion of the file name is 
replaced with the project name. the 
“_wdtitle” must be included in all file 
names.) 

Line#={Label} 

Wd_desc.wdd Component descriptions. Family 
specific description files such as 
PB.wdd, or CR.wdd and be created. 

One text string per line. Can 
have multiple values 
separated with “|”. 

Wd_ratings.wdr Ratings values. (Hint: Add prompts 
to the rating attributes on the 
components to have the prompts 
appear in the View/Edit Rating 
Values dialog box.) 

One text string per line. Can 
have multiple values 
separated with “|”. 

Wdsrcdst.wdd Description lines to assign to 
source or destination arrows. 

One text string per line 
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Default_cat.mdb Part catalog database. Can be 
either Access or SQL. 

 

Default.wdx External text file. Default extension 
is WDX but can also be CSV or 
TXT. External file used to map 
multiple entries to multiple 
attributes. 

One line per entry. Multiple 
values are separated by 
space or comma. 

WD_fam.dat Overrides the family tag code of 
library symbols. 

One line per code. Format is 
{old value},{new value} 

Default.wdn Used by the Electrical Audit for 
excluding terminal duplication in the 
auditing and error checking tools. 
Examples are GND, PE, and E. 

One entry per line. 
Wildcards can be used. 

Default.wdw Contains wire information. color and 
gauge wire descriptions to wire 
layer names 

One line for each wire layer, 
containing three fields 
separated by semi-colans. 
The first field is the wire 
layer name. The second 
field is the wire layer 
description used by the Wire 
Color/Gauge Label tool. The 
third field is the wire size. 

Default.ww1 Contains the conduit information. One line for each conduit, 
containing two fields. The 
first field is the conduit size 
that is shown in the Conduit 
Marker dialog box. The 
second field is the conduit 
size. 

Footprint_Lookup.mdb Used for linking graphical footprints 
to catalog part numbers. 

 

Schematic_Lookup.mdb Used for linking schematic symbols 
to catalog part numbers. 

 

Wd_Lang1.mdb Database for language mapping 
and conversion 
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General Troubleshooting Tips 

How AutoCAD Electrical works is largely driven by three basic concepts: 

• Blocks containing attributes 

• Wires 

• Search paths 

Understanding these basics and checking to make sure they are correct will solve most 

challenges that arise when working with the software. 

Blocks With Attributes 

While stated very simply, this is more than complex than any old block, with any old name, with 
any old attributes. located in any old place on the symbol. 

Symbol Naming Convention 
AutoCAD Electrical uses a specified naming convention for schematic symbols. While not 
absolutely required, using the naming convention provides additional functionality for several 
functions such as catalog searches and symbol swapping. Here is the naming convention used: 

 

 

 

Specifically Named Attributes,  
AutoCAD Electrical uses specifically named attributes, some of which need to be in specific 
locations on the symbol. Two examples of this are the TAG and X?TERM?? attributes. 

A TAG attribute of some kind is required on every symbol. This attribute can come in several 
different forms and is used to uniquely identify every symbol in a project. If any symbols have 
the same value in their TAG attribute, AutoCAD Electrical links them together and considers 
them as the same symbol. 

Here is a table of different type of TAB attributes: 

TAG1 Designates a parent schematic symbol. (Most commonly used) 

TAG2 Designates a child schematic symbol. This symbol will generally need to 
be linked to a parent symbol 

TAG1_PART1 Used to split the TAG value into two separate lines or locations. 
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TAG1_PART2 Used to split the TAG value into two separate lines or locations. 

P_TAG1 Designates a parent panel symbol. 

TAGSTRIP Designates a terminal strip. 

   

Wire Connection Attributes 
X?TERM## attributes are the attributes used to designate wire connection points on a symbol. 

These attributes must be left justified and the insertion point of the attribute is the wire 

connection point. (Hint: The attribute can be rotated if desired for clarity.) The X?TERM## 

attributes are almost always set to Invisible and are usually sized smaller than other attributes. 

The ## represents sequential number that uniquely identifies each attribute on a symbol. If the 

symbol had more than 99 attributes (not generally recommended), letters can also be used. 

The ? value is replaced with a 0, 1, 2, 4, or 8. Each of these values determines which direction 

the wire is coming from and in which direction it will be trimmed. 

0 Radial connection. The wire attaches at an angle from the insertion point of the 

symbol through this connection. (Most commonly used on 3 phase motor symbols) 

1 Wire attaches to connection from the right and will be trimmed to the left. 

2 Wire attaches from the top and will be trimmed to the bottom. 

4 Wire attaches from the left and will be trimmed to the right. 

8 Wire attaches from the bottom and will be trimmed to the top. 

 

If wires are not connecting correctly to a symbol, this is the first place to look. You will need to 

open the symbol from the library and determine if the correct ? values are used. 

Wires 

The definition of a wire in AutoCAD Electrical is “A line on a layer listed in the Create/Edit Wire 
Type dialog box”. Lines in a drawing may look like wires, attaching to symbols and so on, but 
may not actually be wires. The wire definition consists of two parts. 

1) Wires must be line entities. Other types of entities cannot be used. That means no 
polylines, no splines, no arcs, only basic line entities. 

2) The layer the line is on must be displayed in the AutoCAD Electrical Create/Edit Wire 
Type dialog box. 
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The tool for the Create/Edit Wire Type is located on the Schematic tab, Edit Wires/Wire 
Numbers panel, top row, second from the right. (Note: Memorize this tool location) 

 

 

In the Create/Edit Wire Type dialog box layers in the drawing that AutoCAD Electrical will use 
for wires in listed in the upper grid along with other properties and data for the layers. 

 

To add additional layers, you can enter values in the grid or use tools provided. 

Import Tool 
Selecting this tool opens the Wire Type Import – Select Master Drawing dialog box. Select any 
drawing that contains wire layers you want to import.  

(Hint: Drawing a drawing template that contains all wire types your company uses. The wire 
type layer list is stored on the WD_M block in the template drawing. You may want to use the 
template drawing to create your default WD_M block.) 

  



17 
 

In the Import Wire Types dialog box, all wire type layers are selected by default. Select (or de-
select) the layers you want to import from the list and chose the desired options for layers that 
already exist in the current drawing. Click OK and the layer definitions will be imported. 

 

 

Add Existing Layer… 
In many cases, especially when working with existing 
legacy or pre-AutoCAD Electrical drawings, layers may 
already exist that were intended to be wire layers but 
are not listed in the Create/Edit Wire Type dialog box. 
To add those layers to the list, use the Add Existing 
Layer tool. 

In the Layers for Line “Wires” dialog box you can type in 
the existing layer name(s) to add. Wildcards can be 
used as well.  

Or you can use the Pick option to select a wire layer 
from a list of existing layers in the drawing. Only one 
layer at a time can be selected. 
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Search Paths 

Symbol Search Paths 
At some point you will see a version of this 
AutoCAD Message dialog box stating that 
the symbol you selected for insertion 
cannot be found. At first glance this dialog 
box can be pretty over-whelming. Don’t 
panic! It is listing every path where 
AutoCAD Electrical is searching for the 
symbol. In most cases you will only have to 
scan the first several lines to determine if 
the correct paths are being used in your 
project. 

The first two paths are default paths 
AutoCAD Electrical always searches first 
(unless changed in the WD.ENV file). The 
first path is the User folder. This folder 
must always be unique for each individual 
even on shared or network installations. 
The second folder is the active project 
folder. 

The next paths searched are established 
for each project in the Project Properties 
on the Project Settings tab under Library 
and Icon Menu Paths. You can also view 
these paths using the Project Settings tool. 

The next paths searched are the AutoCAD 
Electrical installation folders, followed by 
the AutoCAD folders as listed in the 
Options dialog on the Files tab, under 
Support File Search Path. Except when 
you change the location of the WD_M file, 
you will seldom need to review these folder 
locations. 

  



19 
 

Project Settings 
The Project Settings tool provides several useful tools for checking paths and setting the 
WD.ENV file for the project. At any point you can use this tool to verify any search paths for 
referent files used by the project. Open Project Settings by selecting and right-clicking on the 
active project in the Project Manager and selecting Settings. 

 

The upper window displays the search path settings for individual reference files such as the 
part catalog database. These are determined by both the project WDP file and WD.ENV file. 

The lower window displays the search paths being used for schematic or panel symbol 
insertions. 

Then Environment File button enables you to set the WD.ENV file for the project. 

Miscellaneous Troubleshooting Tools 

Electrical Audit 
One of the most powerful tools in the 
troubleshooting arsenal is the Electrical 
Audit report. This is found on the Reports 
tab, Schematic reports panel. 

The tool scans the entire project looking 
for discrepancies with 10 different design 
topics. If an issue is found, the topic header displays a red X. Not only does the report list the 
design issues but Surfing and editing tools are built into the tool. Select the item and select 
GoTo to open the referenced drawing and the issue will be zoomed into the center of the 
screen. The Electrical Audit remains open while you examine and repair the issue. Once 
repaired the issue count will decrement automatically.  
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The issues listed are not necessarily errors but are items that AutoCAD Electrical determines 
are not standard. If you examine the problem area and determine that the drawing is drawn as 
desired, you can select to Mark As Ignored. The issue(s) can then be hidden from view and the 
issue count will again automatically decrement. 

Before releasing any project out into the world I recommend working to get the issue count to 
zero (0). 

Data Logging 
Sometimes things just don’t work as expected. Thankfully this is rare. Trying to document the 
steps needed to re-create the problem and then contacting Autodesk Support can be frustrating. 
You can create a command trace that saves steps into a log file that you can then send in along 
with your report.  

Follow these steps (uppercase means type the command at the command line). 

1. LOGFILEON 
2. AEONLISPDEBUG 
3. Do the steps that cause the problem 
4. AEOFFLISPDEBUG 
5. LOGFILEOFF 
6. LOGFILENAME 
7. Send the log file indicated in step #6. 

Here’s what each step is doing: 

LOGFILEON Writes the contents of the command history to a file. The contents of 
the text window are recorded in the log file until you exit the program or 
use the LOGFILEOFF command. 

AEONLISPDEBUG Turns on the display of a real-time listing of internal calls in the 
AutoCAD Electrical toolset. 

AEOFFLISPDEBUG Turns off the display of a real-time listing of internal calls in the 
AutoCAD Electrical toolset. 

LOGFILEOFF Closes the command history log file opened by LOGFILEON 

LOGFILENAME Specifies the path and name of the command history log file for the 
current drawing 
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Bonus Topics 

Creating Sub-Projects 

The project file in AutoCAD Electrical is a text-based file contains two main components, project 
settings and a list of drawings reference by the project. Since all other data is stored in the 
drawings themselves, this means that a drawing can be a part of two different projects at the 
same time. 

If the projects are not related to one another, this is probably not a good situation, since it 
means that the last project-wide change will be the one that is saved in the drawings. However, 
if the projects are related it can be a useful tool. 

For example, if you have a large project, need to have unique settings for specific drawings in 
your project, or need different settings than your co-workers, you can create smaller projects, 
each with the unique drawings grouped together. In each smaller sub-project you can run any 
project-wide tools specific for that project without affecting the larger project.  

There will always still be the one main or master project containing all of the drawings. Use this 
“master” project to execute overall project-wide edits and updates. This will provide the 
connectivity and edits between all drawings for overall results such as wire lists, Bill of Material 
reports, and a general overall view of the project. 

Here is an example of this setup: 

   

 

MASTER MENU 

SCHEMATIC SUB-MENU 

PANEL SUB-MENU 
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Here are some key concepts to consider when using sub-menus: 

1. Keep all project files and drawings in the same folder. 
2. One master project will contain all drawings. 

3. Sub-projects will contain smaller partial groups of the same drawings and should be 

mainly self-contained. 

4. Use the master project to synchronize data, such as signal codes between all drawings. 

 

Script creation 

Scripts are a great tool for executing a series of commands in a drawing. Think of scripts as like 
macros in other programs. Combined with the project-wide utilities available in AutoCAD 
Electrical, you have a powerful tool for project-wide editing. For example, a script I use 
frequently changes layer colors, zooms each drawing to extents, and saves the drawing. An 
example of a script file is shown. 

A script is a text file with an SCR file extension. Each line of the script file contains a command 
that can be completed at the Command prompt. They can be easily created using Notepad or 
any other ASCII editor. A script can execute any command at the Command prompt except a 
command that displays a dialog box. In most cases, a 
command that displays a dialog box has an alternative 
version of the command that displays Command prompts 
instead of a dialog box. Most alternative versions of a 
command start with a hypen (-). For example, use -INSERT 
instead of INSERT. 

Here is the workflow to use to create and use a script file: 

1. Open both AutoCAD Electrical and Notepad. 
2. In AutoCAD Electrical type in the command to 

execute. Press Enter. 
3. Duplicate everything you typed in AutoCAD Electrical 

exactly the same way in Notepad, including the Enter. 
Each blank space in a script is significant because it 
is like pressing Enter or the Spacebar. (Long 
filenames that contain spaces must be enclosed with 
quotes.) 

4. In Notepad, save the file with a SCR extension. For 
example, Layer.scr. 
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5. To execute the script in a single drawing: 

a. In AutoCAD Electrical type in “Script” at the command line, or select it from the 

Applications panel, under the Manage tab. (usually hidden).  

b. In the Select Script File dialog box (a standard file selection dialog box), enter the file 

name of a script to run. 

6. To execute the script project-wide: 
a. On the Project tab, Project tools panel, click Utilities. 
b. In the Project-wide Utilities dialog box, under For Each Drawing, select Run 

Command Script. 
c. Browse and select the script file to run. 
d. Click OK. 
e. In the Batch Process Drawings dialog box, select Project. Click OK. 
f. In the Select the Drawings to Process dialog box, select the drawings to be 

processed. Click OK. 

Hints to remember when creating script files: 

• “-“ commands bypass dialog boxes 

• Use the CMDDIA command to turn off the display of some command dialog boxes. 

• Use the FILEDIA command to turn off the display of file selection dialog boxes. 

• Remember to turn these options back on at the end of the script file. 
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Adding a Link to an Alternate Icon Menu 

You can set up AutoCAD Electrical toolset's icon menu system so that you can switch back and 
forth between different icon menus. For example, from the default menu file (such as 
ACE_NFPA_menu.dat) to your own menu (for example "special_menu.dat"). 

1. From the Schematic or Panel tabs, on the Other Tools panel, click Icon Menu Wizard. 
2. In the Select Menu File dialog box, select the menu to be edited. Click OK. 
3. Right-click in an open area of the menu, and select Add Icon > Command. 
4. In the Add Icon Command dialog box, do the following: 

a. Under Name, enter the name of the icon to appear in the menu. 
b. Under Image File, enter an image name, or browse and select a PNG file to 

appear on the icon. 
c. Under Command to Execute, enter the following: 

$C=(c:wd_loadmenu "{special_menu}.dat")(c:wd_insym_go2menu 0) 
5. In your new {special_menu}.dat file, repeat steps 1-4 so you can switch back to the 

original menu.  

The selected menu will immediately appear. 

Here is an example of the menu entry: 

 

 


